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6.1 Getting Started 
 
 

6.1.1 First Steps with Presentations 
 
 
6.1.1.1 Open (and close) a presentation application. 
 
 
To open (start) PowerPoint using the Start Menu 
• Click on the Start button. 
• Click on All Programs. 
• Click on Microsoft PowerPoint. 

 

 
 
 
 
To close PowerPoint 
• Click on the Close icon (the small cross at the top-right of the application window). 

 

 
 
If unsaved changes have been made to your presentation a dialog box is displayed, 
giving you the chance to save the presentation, prior to closing the program. 
 

 
 
• Click Yes to save the presentation before closing 

OR click No to close without saving changes 
OR click on the Cancel button to cancel the operation. 
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6.1.1.2 Open one or several presentations. 
 
 
To open an existing presentation 
• Click on the Open icon. The Open dialog box is displayed. If the file you want to open is 

contained in another folder or drive, move to that location using the Look in: list box. To 
open the file you require, click on the file to select it and then click on the Open button. 
 

 
 
 
Tools to help you with opening files 
• You can use the icons across the top of the Open dialog box to help you in locating and 

selecting the required file. 
 

 
 
Click on the Down arrow to display folders (directories) and drives. 
 

 
 

 Display previous folders. 
 

 Click here to move up one folder level in the directory tree.  
 

 Click here to search the Web.  
 

 Click here to delete the selected file. 
 

 Click here to create a new folder under the selected folder. 
 

 Click on the drop down arrow next to the icon to see a list of selectable views. 
Repeatedly clicking on this icon will cycle through the various views.  
 

 
 
 
To open a recently used PowerPoint file 
• A list of recently opened files is displayed under the File menu. You can open these files 

by clicking on them. 
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To select (& open) a continuous block of files 
• Click on the Open icon, which will display the Open dialog box. 
• Click on the first file of the block which you wish to select and then while depressing the 

Shift key, click on the last file of the required block. When you release the Shift key the 
entire block will remain selected. 

• Click on the Open button to open the files. 
 

 
 
 
To select (& open) multiple files which are not in a continuous block 
• Click on the Open icon, which will display the Open dialog box. 
• Click on the first file which you wish to select and while keeping the Ctrl key depressed, 

click on the other files which you wish to select. When you release the Ctrl key, the 
selected files will continue to be highlighted. 

• Click on the Open button to open the files. 
 

 
 
 
 
6.1.1.3 Create a new presentation (default template). 
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To create a new presentation when starting the PowerPoint application 
• Start PowerPoint. A blank presentation will be displayed by default, as illustrated below. 

 

 
 
 
 
To create a new presentation once PowerPoint is “up and running” 
• Click on the New icon.  

 

 
 
 
 
6.1.1.4 Save a presentation to a location on a drive. 
 
 
To save a presentation 
• Click on the File drop down menu and select Save As to see the Save As dialog box. 
• Ensure that you are located in the folder/disk drive of your choice by clicking the arrow to 

the right of the Save in drop down list box and navigating to your required location. 
• Enter the filename in the File name text box. Filenames cannot include any of the 

following characters: 
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• Click the Save button to complete the file saving process. 
 
 
To save a file to a diskette (floppy disk) 
• Click on the File drop down menu and select the Save As command. A dialog box will 

be displayed similar to the illustration shown. 
 

 
 
• Click on the down arrow to the right of the Save in section of the dialog box, which will 

display a drop down menu, as illustrated. 
 

 
 

• Select the 3 1/2 Floppy (A:) icon. 
• Enter a file name and then click on the Save button. 
 
 
 
6.1.1.5 Save a presentation under another name. 
 
 
To save a presentation using another name 
• Click on the File drop down menu and select the Save As command and within the 

dialog box displayed, enter a different file name. If required, also select a different 
location to save your file to. Click on the Save button (within the Save As dialog box) to 
re-save the file. 

 
 
 
6.1.1.6 Save a presentation in another file type such as: Rich Text 
Format, template, image file format, software specific file extension, 
version number. 
 
 
To save a file in a format other than PowerPoint format, such as RTF 
• From the File drop down menu, click on the Save As command. 
• If necessary, select the folder in which you wish to save the file from the Save in list box. 
• Click on the down arrow to the right of the Save as type: box, and select the type of file 

format you wish to save the file as, such as Outline/RTF. 
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• Enter a file name and then click on the Save button to save it in the required format. 

 
NOTE: Some formatting information which is contained in the original may be lost in the 
process! 

 
 
What is an RTF file? 
• An RTF (Rich Text Format) file is a generic file which can be read and used by a wide 

range of different programs. Thus if you have PowerPoint installed on your PC and wish 
to send a presentation to someone who has a different version of PowerPoint or maybe 
a presentation program other than PowerPoint, you might wish to send the file in RTF 
format.  
 
NOTE: If you have used a lot of complex formatting within your presentation, then an 
RTF file can be a much larger file size compared to a normal PowerPoint file. This may 
be relevant if you are transferring the file over the Internet (or saving the file to diskette 
which is limited to a 1.44 Mb storage capacity). 

 
 
To save your file in a different PowerPoint version 
• This is useful where different departments within your organisation may be using 

different versions of the Microsoft PowerPoint program. Later versions of PowerPoint will 
be able to read presentations saved in earlier versions. However if someone using, say, 
PowerPoint 95, received a presentation formatted in, say, PowerPoint XP, they would be 
unable to open the file. The solution, in this case, is for the person using PowerPoint XP 
to save the file in PowerPoint 95 format, as illustrated. (Note that some formatting 
features may be lost in the process). 
 

 
 
 
To save a file as a template 
• A template is a special type of file which can be created once and customised as 

required. It can then be recycled over and over again. 
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To save a presentation as image formatted files 
• You can, if you wish, save each slide within your presentation as separate Gif or JPG 

picture files. Select the required format from within the Save as Type section of the Save 
As dialog box. 
 

 
 
 
To save an entire presentation in Web format 
• From the File drop down menu, click on the Save as Web Page command. 

 

 
 
This will display a dialog box. If necessary change the file name and save location (via 
the Save in section). 
 

 
 

• If you need to modify other options (such as selecting certain slides), you can click on 
the Publish button, and will see the dialog box below. Close the dialog box when you 
have selected the required options. 
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• Click on the Save button to save the presentation in a Web compatible format. NOTE: 

Some formatting information which is contained in the original may be lost in the 
process! 

 
 
 
6.1.1.7 Switch between open presentations. 
 
 
To switch between open presentations 
• Each presentation which you open will be displayed as an icon within the Windows 

Taskbar, (displayed along the bottom of your screen) as illustrated. 
 

 
 

• To switch to the required presentation, simply click on the icon. 
 
 
 
6.1.1.8 Use available Help functions. 
 
 
What is ‘Today's Tip’? 
• By default PowerPoint will display a "tip of the day" each time you start PowerPoint. If 

you take the time to read these tips as they are displayed, then you will soon find that 
you are on the way to becoming a PowerPoint expert! 
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What is the Microsoft Office Assistant? 
• By default this friendly little creature will watch what you do and offer tips on how to work 

more productively. You can ask it questions in plain English! Occasionally the Office 
Assistant will display information on the screen. If you are unsure about how to use 
PowerPoint you should always read the help offered. You can choose to implement the 
tip, have it explained, or to ignore the tip. 

 
 
To display the Office Assistant 
• The Office Assistant is displayed by default. If the assistant has been hidden you can 

reactivate it, select Show the Office Assistant command from the Help menu. 
 

  
 
 
 
To hide the Office Assistant 
• Right click on the Office Assistant and from the menu displayed, click on the Hide 

command. 
 

 
 
 
To use "What is this" Help 
• Within many dialog boxes you will see a question mark symbol in the top-right corner of 

the dialog box. For instance click on the Format drop down menu, select the Font 
command and this will display the Font dialog box with this sort of help enabled. Not all 
dialog boxes have this feature however. To use "What is this" Help, click on the question 
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mark and then click on the item in the dialog box which you do not understand. 
 

 
 
• In the example shown we have clicked on the Superscript check box within the Font 

dialog box, and as you can see, help is displayed relating to the Superscript option! 
 

 
 
 
The Help drop down menu 
• Click on the Help drop down menu and select the command which you require. 

Remember that if you move the mouse arrow to the down arrow at the bottom of the 
menu, the menu will expand to show all available commands, as illustrated. 
 

 
 
 
Microsoft PowerPoint Help  
• Selecting this option from the Help drop down menu will display the popup menu shown 

below.  
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• Enter your question, as illustrated. 
 

 
 
• Click on the Search button to display Help options. 

 

 
 
• Select the required option, in this case click on Insert a new slide. The instructions will 

be displayed, as illustrated. 
 

 
 
 
‘What’s This’ Help 
• Clicking on this option, under the Help drop down menu will attach a question mark to 

the mouse pointer. When you click on an item you do not understand, you will see a 
popup Help displayed. In the example shown, we have clicked on the Print Preview 
icon. 
 

 
 
 
 
Office on the Web 
• Clicking on this option under the Help drop down menu will display the Microsoft on-line 

web site. Click on the area of the map relating to your locations, and follow the on-screen 
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directions. 
 

 
 
 
Activate Product 
• When you first install the product you need to use this option to make PowerPoint work 

properly. Microsoft force you to use this option in an attempt to stop people making 
illegal copies of the product. If the product has already been activated, you will see the 
following dialog box. 
 

 
 
 
Detect and Repair 
• Selecting this option under the Help drop down menu will display the following dialog 

box. Click on the Start button and follow through the on-screen prompts. 
 

 
 
 
About Microsoft PowerPoint 
• Clicking on this option under the Help drop down menu will display the following dialog 

box. This screen will display the exact release version of the application. It will also 
display your Product ID (removed in the illustration for security reasons). 
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6.1.1.9 Close a presentation. 
 
 
To close a presentation 
• Select Close from the File drop down menu 

 

  
  
OR click on the Close Window icon displayed at the top-right of the presentation 
window. Be sure to click on the Close Window icon, (as opposed to the Close icon). 
 

  
 
The presentation will be closed and the screen will be cleared. If you try to close a 
presentation without saving it, PowerPoint displays a dialog box asking if you want to 
save any of the changes you made to the presentation. 

 
 
 

6.1.2 Adjust Settings 
 
 
6.1.2.1 Use magnification/zoom tools. 
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To zoom a presentation using the Zoom icon 
• This feature allows you to enlarge or reduce the view of a page on the screen. You can 

display the whole page, or just a section of it. Use the Zoom icon on the Standard 
toolbar to quickly zoom to certain settings. Click on the down arrow next to the Zoom 
icon to display a drop down list of pre-set screen zoom values. 
 
NOTE: You can enter any value you like; you do not have to accept the values offered to 
you. 
 

 
 
 
 
6.1.2.2 Display or hide built-in toolbars. 
 
 
To display or hide a toolbar 
• To display a toolbar, select the Toolbars command from the View menu to display the 

Toolbars drop down menu. A list of toolbars is displayed. Choose the Toolbar you want 
to display by clicking on it from the list. 
 

 
 
 
Quick way of displaying / hiding toolbars 
• A quick way of displaying/hiding toolbars is to right click on an existing toolbar which will 

display the Toolbars drop down menu, from which you can select or de-select toolbars. 
 
 
 
6.1.2.3 Modify basic options/preferences in the application: user name, 
default directory/folder to open, save presentations. 
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To set preference options 
• Click on the Tools drop down menu and select the Options command. 

 
To set the user name: Select the General tab, and enter your name in the Name and 
Initials section of the dialog box. Once set, this means that PowerPoint can use the 
stored information at a later date. 
 

 
 
To set the default directory: Select the Save tab, and enter the default file location 
within the dialog box. Once set this means that open and close dialog boxes will point to 
the specified folder. 
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6.2 Developing a Presentation 
 
 

6.2.1 Presentation Views 
 
 
6.2.1.1 Understand the uses of different presentation view modes. 
 
 
Normal View 
• When in Normal view, you will see a representation of the slide. Below it is an area for 

adding speaker’s notes and to the left is a representation of the presentation in Outline 
view. This is the most versatile view of a presentation when editing and reviewing 
changes. 
 

 
 
 
Slide Sorter View 
• This view shows all the slides laid out on the screen, and within this view you can use 

'drag and drop' techniques to reorder the slides. 
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Slide Show View 
• The Slide Show view displays the presentation as an on-screen show. This allows you to 

see the presentation in the same format in which it will be presented to an audience. 
 

 
 
 
 
 
6.2.1.2 Change between different presentation view modes. 
 
 
To change between presentation views 
• Just above the Windows Status Bar, at the bottom-left of the screen, you will see the 

PowerPoint View icons. These are used to change the view of the PowerPoint 
presentation on which you are working. Simply click on the required view icon. 
 

 
 
The Views available are: 
- Normal View 
- Slide Sorter View 
- Slide Show View 

 
 
To change between slide and outline view 
• In Normal view you can select to display slides or a presentation outline down the left of 

your screen, using the Outline or Slides tabs, as illustrated. 
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6.2.2 Slides 
 
 
6.2.2.1 Add a new slide with specific slide layout inc: title slide, chart & 
text, bulleted list, table. 
 
 
To add a new slide with a specific slide layout (using the New Slide icon) 
• Click on the New Slide icon. 

 

 
 

• From the New Slide task pane (displayed down the right hand side on the window), 
select the required slide layout. 
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• In the example illustrated, we selected the ‘Title and 2-Column text’ slide layout. As you 
can see the slide is formatted accordingly. 
 

 
 
 
 
6.2.2.2 Change between built-in slide layouts. 
 
 
To apply a different slide layout to a slide 
• Display a slide within a presentation where you wish to change the slide layout. 
• Right-click on the slide and from the popup menu displayed, select the Slide layout 

command, as illustrated. 
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• This will display the Slide Layout task pane. Select the required slide layout. 
 

 
 
 
 
6.2.2.3 Change background colour on specified slide(s), all slides. 
 
 
To change the background colour of the selected slide (or for every slide 
within a presentation). 
• Click on the Format drop down menu, and select the Background command. This will 

display a dialog box. Select the required colour. 
 

 
 

• To apply this background colour to the selected slide, click on the Apply button. 
• To apply this background colour to all the slides within the presentation click on the 

Apply to All button. 
 
 
To change the background colour of the multiple selected slides 
simultaneously 
• Let’s say that you have a slide show made up of many slides and that you wish to 

change the background colour of some of the slides. To do this, you need to first select 
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the slides which you wish to format with the background colour. Click on the Slide Sorter 
View icon (bottom-left of your screen). Click on the first slide which you wish to select. 
While depressing the Ctrl key, click on the other slides which you wish to select. 

• When all the required slides are selected, click on the Format drop down menu, and 
select the Background command. This will display a dialog box. 

• Select the required colour. 
To apply this background colour to the selected slides, click on the Apply button. 

 
 
 

6.2.3 Using Design Templates 
 
 
6.2.3.1 Apply an available design template to a presentation. 
 
 
To apply a design template 
• Display the presentation to which you wish to apply a design template. 
• Click on the Format drop down menu and select the Slide Design command, which will 

display the Slide Design task pane down the right side of the window. 
 

 
 

• Select the Slide Design required. In the example shown we have selected the Fireworks 
Slide Design. 
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6.2.3.2 Change between available design templates. 
 
 
To change to a different design template 
• Display the presentation to which you wish to apply a different design template. 
• Click on the Format drop down menu and select the Slide Design command, which will 

display the Slide Design task pane down the right side of the window. Select the 
required slide design to apply it. 

 
 
 

6.2.4 Master Slide 
 
 
What are Slide Masters and Design Templates? 
• Slide Masters are basically templates which are used to create a new presentation. Click 

on the File drop down menu, and then click on the New command. The New 
Presentation task pane is displayed down the right-hand side of the screen.  Select 
General Templates and by default the General tab is displayed, which contains the 
default template entitled Blank Presentation. However if you investigate the other tabs, 
such as Presentation Designs or Presentations, you will see other templates.  These 
templates are held as individual files, with a .POT file extension. Each presentation which 
you create will be based on an existing template, often the default Blank presentation 
template, and it is this template which defines what sort of background colour and 
graphics will be used in the presentation, along with the positioning of the text, as well as 
the formatting used by the text. Information such as the type of bullet used will be stored 
within the template file. 
 
Each template file contains what are called “Masters” which define how the different 
views will be formatted, i.e. you have a Slide Master, an Outline Master, a Notes Master 
and a Handouts master. The idea of a Slide Master is to help you impose a consistent 
look and feel on all the presentations which you produce. You can however override the 
master settings for an individual slide. You can also customise the master settings as 
used by a particular presentation file. 

 
 
 
6.2.4.1 Insert a picture, image, drawn object into a master slide. Remove 
a picture images, drawn object from a master slide. 
 
 
To insert a picture into a master slide 
• Display an existing presentation within PowerPoint. 
• Click on the View drop down menu and select the Master command. From the submenu 

displayed, select the Slide Master command, which will display the underlying slide 
master for that presentation. 
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• Click on the Insert Clip Art icon (within the Drawing toolbar).  
 

 
 

• Select a category and then select an item of clipart. Insert the clipart item. 
• Once the required graphic has been inserted, positioned and re-sized as necessary, you 

can switch back to the normal slide view by clicking on the Normal View icon, displayed 
at the bottom-left of your PowerPoint screen. 
 

 
 
 
 
To insert an image (from a file) into a master slide 
• Display an existing presentation within PowerPoint. 
• Click on the View drop down menu and select the Master command. From the submenu 

displayed, select the Slide Master command, which will display the underlying slide 
master for that presentation. 

• Click on the Insert drop down menu and select the Picture command. From the 
submenu displayed, select From File. If necessary browse the hard disk until the 
required image file is displayed.  
 

 
 

• Select the image file and click on the Insert button. 
• Once the required graphic has been inserted, positioned and re-sized as necessary, you 

can switch back to the normal slide view by clicking on the Normal View icon, displayed 
at the bottom-left of your PowerPoint screen. 

 
 
To insert a drawn object into a master slide 
• Display an existing presentation within PowerPoint. 
• Click on the View drop down menu and select the Master command. From the submenu 

displayed, select the Slide Master command, which will display the underlying slide 
master for that presentation. 

• Display the drawing toolbar, and create a drawn object, i.e. AutoShape. 
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• Once the required graphic has been inserted, positioned and re-sized as necessary, you 
can switch back to the normal slide view by clicking on the Normal View icon, displayed 
at the bottom-left of your PowerPoint screen. 

 
 
To remove a graphic from a master slide 
• Switch to Slide Master view (by clicking on the View drop down menu, selecting Master, 

and then from the submenu displayed selecting Slide Master). 
• Select the image which you wish to remove (by clicking on it). 
• Press the Del key to delete the image. 
 
 
 
6.2.4.2 Add text into a footer of specific slides, all slides in a 
presentation. 
 
 
To add footer text to a presentation 
• Display the presentation to which you wish to add a header or footer. 
• Click on the View drop down menu and select the Header and Footer command, which 

will display a display box. If necessary select the Slide tab. 
 

 
 

• Click on the Footer check box and enter the footer text which you wish to be displayed. 
• Either click on the Apply button to add the footer to just the current slide within the 

presentation or click on the Apply to All button to add the footer to all the slides within 
the presentation. 
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6.2.4.3 Apply automatic slide numbering, automatically updated date, 
non-updating date, into Footer of all specific slides, or all slides in a 
presentation. 
 
 
To add automated slide numbering and the date to a presentation 
• Display the presentation to which you wish to add slide numbering and date information 

which will automatically update. 
• Click on the View drop down menu and select the Header and Footer command, which 

will display a display box. If necessary select the Slide tab. 
• To apply automatic slide numbering, click on the Slide number button within the dialog 

box. 
 

 
 

• To apply an automatically updating date, click on the Update automatically button 
within the dialog box. 
 

 
 

• Click on the Apply to All button to add the header or footer to all the slides within the 
presentation. 
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6.3 Text and Images 
 
 

6.3.1 Text Input, Formatting 
 
 
6.3.1.1 Add text into a presentation in standard or outline view. 
 
 
To add text to a slide in Normal (standard) view 
• Click on the Normal view icon (bottom-left of your screen). 

 
 

 
The screen layout will be similar to that illustrated. 
 

 
 

• Click at the location within a slide where you wish to add text. As you can see from the 
illustration below, where we have clicked within the Title area, a text box is displayed. 
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• Enter your text, as illustrated. 
 

 
 
 
To add text to a slide in Outline view 
• When you click on the Normal icon (bottom-left of your screen) the screen is displayed in 

Normal view. If you look carefully, you will notice that Outline and Slides tabs are 
displayed to the left of the screen. 
 

 
 
• Clicking on the Outline tab will display the presentation in outline view, as illustrated. 
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You can if necessary scroll down the text which is displayed in the left section of the 
dialog box. You can enter new text, or edit existing text, in the same way that you would 
enter text into a word-processing program. I.e. just click where you wish to enter some 
text and start typing. 

 
 
 
6.3.1.2 Edit slide content, notes pages contents by inserting new 
characters, words 
 
 
To edit slide content 
• Use the same editing techniques which you would use within a word-processor. 

 
To insert text: Click at the point you wish to insert text and start typing. 
 
To overwrite existing text: Select the text you wish to replace with new text. Start 
typing and the new text will replace the old text. 

 
 
To edit text on a notes page 
• To edit notes pages, use the same techniques as above, and edit the notes text which is 

displayed under the slide in Normal View. 
 
 
 
6.3.1.3 Change text appearance: font sizes and font types. 
 
 
To change the font type used by selected text 
• Select the text of which you wish to change the font. 
• Click on the down arrow next to the Font field in the Formatting toolbar. 
• Select the new font from the list displayed. 

 

 
 
 
To change the font size used by selected text 
• Select the text of which you want to change the font size, or place the insertion point at 

the location where you want to begin entering text in the new size. 
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• Enter the font size required into the Font Size field in the Formatting toolbar. 
 

 
 
• You can also use the toolbar icons Increase Font Size and Decrease Font Size. 

 

 
 
 
 
6.3.1.4 Apply text formatting such as bold, italic or underlining. 
 
 
To format using Bold, italic or underlining 
• Select the text you wish to format. 
• You can change the font style by clicking the Bold, Italic, Underline and Shadow icons 

from the Formatting toolbar. 
 

 
 
 
 
6.3.1.5 Apply case changes to text. 
 
 
To change text case 
• Select the text of which you wish to change the case. 
• Click on the Format drop down menu and select the Change Case command. 
• From the dialog box displayed, select the required option and click on the OK button to 

apply the case formatting. 
 

 
 
 
 
6.3.1.6 Apply different colours to text. 
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To change the Font colour 
• Select the text to which you wish to apply the new colour. 
• Click on the down arrow next to the Font Colour icon on the Drawing toolbar. 
• Select the required colour from the drop down displayed. 

 

 
 
• To see other colours click on the More Colors command. This will allow you to select 

more colours, or define your own colours. 
 

 
 
 
 
6.3.1.7 Apply shadow to text. 
 
 
To add a shadowed effect to text 
• Select the text to which you wish to apply the shadowed effect. 
• Click on the Shadow icon on the Formatting toolbar. 

 

 
 
 
 
6.3.1.8 Align text: left, centre, right in a slide. 
 
 
To change paragraph alignment 
• Use the Align icons in the toolbar. There are several options available. 
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Left: Text is aligned flush with the left-hand edge of a text object (the default). 
 
Right: Text is aligned flush with the right-hand edge of a text object. 
 
Centre: Text is centred horizontally between the left and right hand edges of a text 
object. 

 
• To change the alignment of a paragraph, select the paragraph(s) you wish to change. 
• Select Alignment from the Format menu. A submenu is displayed containing various 

options. 
 

 
 
• Select the option you require. 
 
 
To centre text top and bottom 
• By default text boxes automatically wrap and re-size to fit the text within them. However 

if you wish to set the formatting to align any text within a text box to centre vertically, i.e. 
between the top and bottom of the text box, then this is how you would do it. 

• First click on the text box to select it. 
• Right click on the text box to display a popup menu and select the Format Text Box (or 

Format Placeholder) command. 
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• This will display the Format dialog box. Select the Text Box tab. 
 

 
 
• From the Text anchor point section of the dialog box, use the drop down arrow to select 

Middle Centred. 
 

 
 
 
 
 
6.3.1.9 Adjust line spacing before and after bulleted, numbered points. 
 
 
To change line and paragraph spacing 
• Line spacing is the amount of space between lines of text or between paragraphs. You 

may wish to adjust the line spacing to make text easier to read, or to make text fit on a 
slide. Spacing can be adjusted in lines or points. 

• To change the line spacing, select the text or paragraph(s) where you want to adjust the 
spacing. Select Line Spacing from the Format menu to display the Line Spacing dialog 
box. 
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• To adjust the line spacing, use the up and down arrows in the Line spacing box to 
change the value. Select how you wish to adjust the spacing by choosing Lines or 
Points from the drop-down list on the right-hand side of the adjustment box. 

• To adjust the paragraph spacing, use the up and down arrows in the Before paragraph 
and After paragraph boxes to adjust the value. Select how you wish to adjust the 
spacing by choosing Lines or Points from the drop-down list on the right-hand side of 
the adjustment box. 

• Select Preview to see the effect the new spacing has on the text. Select OK to accept 
the new spacing attributes. 

 
 
 
6.3.1.10 Change between style of bullets or numbers in a list from the 
built-in standard options. 
 
 
To add bullets using the toolbars 
• Select the text to which you want to add bullets. 
• Click on the Bullets icon in the Formatting toolbar. 

 

 
 
 
To remove bullets 
• Select the bulleted text from which you wish to remove the bullet formatting. 
• Click the Bullets icon on the Formatting toolbar to switch the bulleting feature off. The 

bullets are removed from the text. 
 
 
To select a different bullet type 
• Select the text to which you want to add bullets. 
• Select Bullets and Numbering from the Format menu to display the Bullets and 

Numbering dialog box. Make sure the Bulleted tab is selected. Select the required 
bullet and click on the OK button. 
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To select a different numbering format 
• Select the text to which you want to add numbering. 
• Select Bullets and Numbering from the Format menu to display the Bullets and 

Numbering dialog box. Make sure the Numbered tab is selected. Select the required 
number format and click on the OK button. 
 

 
 
 
 
6.3.1.11 Use the undo or redo command. 
 
 
To use the Undo command 
• Click on the Undo icon. 

 

 
 
 
To use the Redo command 
• Click on the Redo icon. 

 

 
 
 
 

6.3.2 Pictures, Images 
 
 
EXTRA - Picture Selection Techniques 
 
 
To select a picture 
• Click on the object to select it. 
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To select multiple pictures 
• Click on the first object to select it. 
• Depress the Shift key (and keep it depressed). 
• Click on other objects which you also wish to select. 
• Release the Shift key and all the objects on which you have clicked will remain selected. 
 
 
To select all pictures within a slide 
• Press Ctrl+A. 
 
 
To 'cycle' round all pictures and select them one, by one 
• Press the Tab key and each time you press the Tab key, you will cycle round the objects 

within the slide (including the text boxes). 
 
 
 
6.3.2.1 Insert a picture into a slide. 
 
 
To insert Clipart 
• Click on the Insert Clip Art icon, located in the Drawing toolbar. The Insert Clip Art task 

pane will be displayed, as illustrated. 
 

  
 
• Enter a word which describes the type of clipart which you are looking for. For instance 

enter the word computer and then click on the Search button. The results would be as 
illustrated.  
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• Click on the required clipart to insert it. 

 

 
 
 
 
6.3.2.2 Insert an image into a slide. 
 
 
To import an image from a file 
• Display a slide within your presentation. 
• Click on the Insert drop down menu, select the Picture command, and from the 

submenu displayed select From File. If necessary change to the required drive or folder 
and then select the required picture file. You should see a preview of the selected picture 
file within the dialog box. 
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• Once the correct file is selected, click on the Insert button and the picture will be 

displayed within your slide.  
 
NOTE: If you click on the down arrow in the Files of type section of the Insert Picture 
dialog box, you will see a list of file types which you can insert into your presentation. 
 

 
 
 
 

6.3.3 Duplicate, Move, Delete 
 
 
6.3.3.1 Duplicate text, pictures, images within the presentation or 
between open presentations. 
 
 
What is the Clipboard? 
• The Clipboard is an area of memory in which you can store text or graphics. 
• The Clipboard is used to temporarily store data whilst it is being moved between 

documents or applications, or from one place to another in the same document. If you 
cut or copy text, graphics, or other items, they will be temporarily stored in the Clipboard 
ready for use elsewhere. 

 
 
The Copy command 
• When you use the Copy command the Clipboard is used to store a copy of the selected 

text (or graphics) without removing it from the document. This enables you to paste a 
copy of the text (or graphics) from the Clipboard to another location in the same 
document, to a different document, or to another Windows program. 
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To copy text, graphics, or other items to the Clipboard 
• Select the item you wish to copy to the Clipboard. 
• From the Edit menu select the Copy command  

OR press Ctrl+C, to move the item to the Clipboard without removing it from the 
document 
OR you can also use the Copy icon on the Standard toolbar.  
 

 
 
 

To copy (or cut) multiple items to the Clipboard and Paste them into a 
presentation 
• When you copy more than one item into the Microsoft Office Clipboard, the Clipboard 

task pane will be displayed down the right of the screen as illustrated. 
 

 
 

 
To paste data from the Clipboard 
• Select the text you wish to Cut or Copy. 
• Use the Cut or Copy command to place the data in the Clipboard. 
• Then locate the insertion point at a different location within your current document (or 

indeed in a different document, or even a different Windows program!). 
• From the Edit menu, choose the Paste command 

OR press Ctrl+V 
OR you can also paste items using the Paste button on the toolbar. 
 

 
 
 
To copy using “Drag and Drop”, without placing text in the Clipboard 
• Select the text you wish to copy and then place the mouse pointer anywhere over the 

selected text. Hold down Ctrl and depress the left-hand mouse button. Note that the 
mouse pointer changes to an arrow with a dotted insertion point contained in a box. 

• Drag the mouse pointer to the required new location. Release the mouse button and the 
Ctrl key to move the text to the new location. 
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Copying, cutting and deleting images 
• You can copy, move and delete images in almost exactly the same way that you would 

manipulate selected text. You can use drag and drop techniques or use the Clipboard, 
along with the Cut, Copy and Paste commands. 

 
 
To copy and paste an image 
• Select the image you wish to copy to the Clipboard. 
• Then from the Edit menu select the Copy command  

OR press Ctrl+C, to move the image to the Clipboard without removing it from the slide. 
OR you can also use the Copy icon on the Standard toolbar.  
 

 
 
• Once the image is stored within the Clipboard, position the insertion point within a slide, 

at the position where you wish to paste the image. Then click on the Paste icon. 
 

 
 
 
To copy an item from one slide to another within a presentation 
• Select the text, image, drawn object, or chart which you wish to copy. 
• Press Ctrl+C to copy the selected item to the Clipboard. 
• Use the Next slide/Previous slide controls to display the slide to which you wish to 

copy the item. 
 

 
 

• If the item you copied to the Clipboard was text, then click within the slide at the location 
where you wish to paste the text, or else simply paste the item into the slide. Remember 
that the keyboard shortcut to paste is Ctrl+V. If the item was not text, you may have to 
use the normal 'drag and drop' techniques to move the item within the slide. 

 
 
To copy an item from a slide in one presentation to a slide within a different 
presentation 
• Select the text, image, drawn object, or chart which you wish to copy. 
• Press Ctrl+C to copy the selected item to the Clipboard. 
• Click on the Window drop down menu, and select the other, open PowerPoint 

presentation, to which you wish to paste the copied item. 
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• If necessary, within this second presentation, use the Next slide/Previous slide controls 
to display the slide to which you wish to copy the item. 
 

 
 

• If the item you copied to the Clipboard was text, then click within the slide at the location 
where you wish to paste the text, or else simply, paste the item into the slide. Remember 
that the keyboard shortcut to paste is Ctrl+V. If the item was not text, you may have to 
use the normal 'drag and drop' techniques to move the item within the slide. 

 
 
To copy a slide from one place to another within a presentation 
• Click on the Slide Sorter View icon (bottom-left) 

 

 
 

• Select the slide which you wish to copy. 
• Press Ctrl+C to copy the entire slide to the Clipboard. 
• Click between the two slides where you wish to paste the copied slide (a thin vertical line 

marks the insertion point for you) 
• Press Ctrl+V to paste the copied slide. 
 
 
 
To copy a slide within one presentation to a slide within a different 
presentation 
• Click on the Slide Sorter View icon (bottom-left) 

 

 
 

• Select the slide which you wish to copy. 
• Press Ctrl+C to copy the entire slide to the Clipboard. 
• Click on the Window drop down menu, and select the other, open PowerPoint 

presentation, to which you wish to paste the copied slide. 
 

 
 

• Click on the Slide Sorter View icon (bottom-left), so that the slides of the second 
presentation are displayed in slide sorter view. 

• Click between the two slides where you wish to paste the copied slide (a thin vertical line 
marks the insertion point for you) 

• Press Ctrl+V to paste the copied slide. 
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6.3.3.2 Move text, pictures, images within the presentation or between 
open presentations. 
 
 
The Cut command 
• The Cut command allows you to remove text, graphics, tables, and other items from a 

document and store it on the Clipboard. The item can then be pasted from the Clipboard 
to another location in the document, to another document, or to a document in another 
Windows program. Remember that, unlike the Copy command, Cut will remove the 
selected item from the document. You can restore it by using the Undo command. 

 
 
To cut selected items from a document 
• Select the items you want to cut. 
• From the Edit menu choose the Cut command 

OR press Ctrl+X, to cut the item from the document and place it on the Clipboard 
OR you can also cut items by clicking on the Cut button on the Standard toolbar. 
 

 
 
 
To move text using “Drag and Drop”, without storing it on the Clipboard 
• Select the text you wish to move. Place the mouse pointer anywhere on the selected text 

and hold down the left-hand mouse button. Note that the mouse pointer changes to an 
arrow with a dotted insertion point contained in a box. 

• Drag the mouse pointer to a new location. To move the text to its new location, release 
the mouse button. 

 
 
To cut (move) an item from one slide to another within a presentation 
• Select the text, image, drawn object, or chart which you wish to move. 
• Press Ctrl+X to cut the selected item to the Clipboard. 
• Use the Next slide/Previous slide controls to display the slide to which you wish to 

move the item. 
 

 
 
• If the item which you moved to the Clipboard was text, then click within the slide at the 

location to which you wish to paste the text, or else simply, paste the item into the slide. 
Remember that the keyboard shortcut to paste is Ctrl+V. If the item was not text, you 
may have to use the normal 'drag and drop' techniques to move the item within the slide. 
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To cut (move) an item from a slide in one presentation to a slide within a 
different presentation 
• Select the text, image, drawn object, or chart which you wish to move. 
• Press Ctrl+X to move the selected item to the Clipboard. 
• Click on the Window drop down menu, and select the other, open PowerPoint 

presentation, where you wish to paste the cut item. 
 

 
 
• If necessary, within this second presentation, use the Next slide/Previous slide controls 

to display the slide where you wish to cut the item. 
 

 
 

• If the item which you cut to the Clipboard was text, then click within the slide at the 
location where you wish to paste the text, or else simply, paste the item into the slide. 
Remember that the keyboard shortcut to paste is Ctrl+V. If the item was not text, you 
may have to use the normal 'drag and drop' techniques to move the item within the slide. 

 
 
 
6.3.3.3 Resize pictures, images in a presentation. 
 
 
To resize an image, object or chart 
• Select the image, object or chart by clicking on it once. 
• Move the mouse pointer to one corner of the selected item, until the mouse pointer 

changes to a line at 45 degrees with an arrowhead at each end. 
• Depress the mouse button and drag to resize the image within the slide. 
• Release the mouse button. 
 
 
 
6.3.3.4 Delete text, pictures, images in a slide. 
 
 
To delete selected text 
• Select the text which you want to delete and press the Delete key. 
 
 
To delete a picture 
• Click on the picture which you wish to select and then press the Delete key. 
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6.4 Charts/Graphs Drawn Objects 
 
 

6.4.1 Using Charts/Graphs 
 
 
6.4.1.1 Input data to create or modify different kinds of built-in 
charts/graphs in a slide such as; column, bar, line, pie. 
 
 
To create a column, bar or line chart 
• Open or create a presentation. 
• Click on the New Slide icon. 
• Select the Title and Chart AutoLayout. 

 

 
 
An icon is inserted into the slide, as illustrated. 

 
• Double clicking on this icon will insert a Column Chart using sample data, as illustrated. 

You can modify the data as required. 
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• By default a column chart will be created. If you wish to create a different type of chart, 

then click on the Chart drop down menu and select the Chart Type command. 
 

 
 
• From the dialog box displayed, select the required chart type, such as Column, Bar or 

Line. 
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• Click on the OK button to confirm your chart type selection. 
• Click on the Close icon (top-right of the Datasheet window) to complete the process. 
 
 
To create a Pie chart 
• Open or create a presentation. 
• Click on the New Slide icon. 
• Select the Title and Chart AutoLayout, as illustrated, and click on the OK button. 

 

 
 
An icon is inserted into the slide, as illustrated. 

 
 
• Double clicking on this icon will insert a column chart using sample data, as illustrated. 

You can modify the data as required. 
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• By default a column chart will be created. You can modify the data as required. 

 
NOTE: When wishing to create a Pie chart you have to use only one data series. In the 
data illustrated, we have three data series, i.e. East, West and North, as illustrated. 
 

 
 
• In this case we shall use the East data series, in which case we need to de-select the 

West and North data series. To do this, double click on the icon numbers to the left of 
West and North, as illustrated below. 
 

 
 
• Now only the East data series is selected. 
• Click on the Close icon (top-right of the Datasheet window) to complete the process. 
• To convert the chart from a column chart to a pie chart, click on the Chart drop down 

menu and select the Chart Type command. This will display the Chart Type dialog box. 
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• Select the required chart type, in this case a Pie chart. 

NOTE: You can use the Chart sub-type section of the dialog box to make further 
modifications. 

 
• Click on the OK button to finish the process. The Pie chart will be displayed, as 

illustrated. 
 

 
 
 
 
6.4.1.2 Change the background colour in the chart/graph. 
 
 
To change the background colour of a chart 
• Display the slide containing the chart which you wish to modify. 
• Double click over the chart area, so that the screen changes as illustrated below (the 

data used to construct the chart is displayed, and if you look carefully, you will see 
different icons displayed across the top of your application). 
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• Right click over the chart background, and from the popup menu displayed, select the 

Format Chart Area command.  
 

 
 
This will display the Format Chart Area dialog box. 
 

 
 
• Select the required colour and then click on the OK button. An example is illustrated 

below. 
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6.4.1.3 Change the column, bar, line, pie slice colours in the chart/graph. 
 
 
To change the colour of a chart column, bar, line or pie slide 
• Display the slide containing the chart which you wish to modify. 
• Double click over the chart area, so that the screen changes allowing you to select 

individual elements within the chart. 
• Double click on either the column, bar, line or pie slide, and you will see a dialog box, like 

the one illustrated.  
 

 
 

• Select the required colour and then click on the OK button to apply the colour changes. 
 
 
 
6.4.1.4 Change the chart/graph type. 
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To change the type of chart displayed 
• Display the slide containing the chart which you wish to modify. Double click over the 

chart area, so that the screen changes and the chart editing icons are displayed in the 
toolbar. 

• Click on the Chart drop down menu and select the Chart Type command. This will 
display a dialog box. 
 

 
 

• Select the required chart type, and then click on the OK button. 
 
 
 

6.4.2 Organisation Charts 
 
 
6.4.2.1 Create an organisation chart with a labelled hierarchy. 
 
 
To create a slide containing an organisational chart 
• Click on the New Slide icon and select the ‘Title and Diagram or Organisational Chart’ 

AutoLayout. 
 

 
 
A new slide is inserted as below. 
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• Double click on the icon within the new slide called ‘Double click to add diagram or 
organisation chart’. The Diagram Gallery will be displayed. 
 

 
 
• Make sure that the Organisation Chart option is selected  

 

 
 
and then click on the OK button. This will insert an organisation chart, as illustrated. 
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To enter information into an organisation chart box 
• Enter the data into the boxes, overtyping the existing text (i.e. Click to add text). 
 
 
 
6.4.2.2 Change the hierarchical structure of an organisation chart. 
 
 
To move boxes within the chart 
• You have an organisational chart which looks like this. 

 

 
 
• Click on the edge of the box which you wish to move, so that the box is surrounded by 8 

'handles' as illustrated. In this case we clicked on the edge of the Dave box. 
 

  
 
• Depress the left mouse button and drag the Dave box, exactly over the Lou box. When 

you release the mouse button you will see the following. 
 

 
 
 
 
6.4.2.3 Add or remove managers, co-workers, subordinates in an 
organisation chart. 
 



PAGE 56 - ECDL MODULE 6 (USING POWERPOINT XP) - MANUAL 

FOR USE AT THE LICENSED SITE(S) ONLY  
© Cheltenham Courseware for Trainers 1995-2004 www.cctglobal.com 

 
To add chart boxes 
• Click on the item to which you wish to add. You can add boxes to the chart using the 

Organisation Chart toolbar (which is displayed automatically when an organisational 
chart is selected). Click on Insert Shape drop down menu and select subordinate, co-
worker or Assistant. 
 

 
 
 
To remove chart boxes  
• Click on the box you want to remove to select it. Press the Delete key. 

 
NOTE: If you want to delete more than one box, press the Shift key as you click on the 
boxes to select them and then press the Delete key. 

 
 
 
 

6.4.3 Drawn Objects 
 
 
6.4.3.1 Add different types of drawn object to a slide: line, free drawn 
line, arrow, rectangle, square, circle, text box, other available shapes 
 
 
To display the drawing toolbar 
• Right click on any toolbar and from the popup menu displayed select Drawing. 

 

 
 
 
To draw a line 
• Select the Line icon from the Drawing toolbar. The mouse pointer changes into a cross-

hair pointer when moved over the slide.  
 

 
 
• Click at the location where you want the line to begin and drag. Release the mouse 

button when you want the line to end. A line appears between the beginning and end 
point. 
 
TIP: To draw a line which is perfectly horizontal or vertical, depress the Shift key while 
dragging. 
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To add a free drawn line 
• Click on the AutoShapes button within the Drawing toolbar and from the popup menu 

displayed select Lines. 
• From the submenu, select the Scribble icon. 

 

 
 
• Click at the location where you want the line to begin and start moving the mouse. 

Release the mouse button when you want the line to end. 
 
 
To insert a line with an arrow on it 
• Click on the AutoShapes button within the Drawing toolbar and from the popup menu 

displayed select Lines. 
• From the submenu, select the Arrow icon. 

 

 
 
• Click at the location where you want the line to begin and start moving the mouse. 

Release the mouse button when you want the line to end. 
 
 
 
To insert an arrow 
• Click on the AutoShapes button within the Drawing toolbar. 
• Click on the Block Arrows command. 
• From the submenu, select the required arrow type. 

 

  
 
• Click at the location where you want the arrow to begin and start moving the mouse. 

Release the mouse button when you want the arrow to end. 
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To insert a rectangle 
• Click on the Rectangle icon within the Drawing toolbar. 

 
 

 
• Move the mouse pointer over the slide area and click at the position where you wish to 

start drawing the rectangle. 
• Move the mouse pointer diagonally across the screen. 
• Release the mouse pointer when you have finished. 
 
 
To insert a square 
• Click on the Rectangle icon within the Drawing toolbar. 

 
 

 
• Depress the Shift key (and keep it depressed). 
• Move the mouse pointer over the slide area and click at the position where you wish to 

start drawing the square. 
• Move the mouse pointer diagonally across the screen. 
• Release the mouse pointer when you have finished. 
• Release the Shift key. 
 
 
To insert an oval 
• Click on the Oval icon within the Drawing toolbar. 

 

 
 

• Move the mouse pointer over the slide area and click at the position where you wish to 
start drawing the oval. 

• Move the mouse pointer diagonally across the screen. 
• Release the mouse pointer when you have finished. 
 
 
To insert an circle 
• Click on the Oval icon within the Drawing toolbar. 

 

 
 

• Depress the Shift key (and keep it depressed). 
• Move the mouse pointer over the slide area and click at the position where you wish to 

start drawing the circle. 
• Move the mouse pointer diagonally across the screen. 
• Release the mouse pointer when you have finished. 
• Release the Shift key. 
 
 
To insert a Text Box 
• You can insert a new text box using the Text Box icon. This icon is contained on the 

Drawing toolbar.  
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Once you have clicked on this icon, click within the body of the slide. A text box will be 
inserted as illustrated.  
 

 
 

• You may start to enter text within this text box, as illustrated. 
 

 
 
 
 
6.4.3.2 Change drawn object background colour, line colour, line weight, 
line style. 
 
 
To change an object’s background colour, line colour, line weight and line type 
• Click on an object to select it. 
• Double click on the object to display a dialog box, similar to the one illustrated. 

 

 
 
• Make sure that the Colors and Lines tab is selected. 
• To change the background colour, click on the down arrow to the right of the Color 

option within the Fill section. Select a colour as required. 
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• To change the background colour, click on the down arrow to the right of the Color 

option within the line section. Select a colour as required. 
 

 
 
• To change the line weight, click on the up or down arrow to the right of the Weight option 

within the Line section. Select a line weight as required. 
 

 
 
• To change the line style, click on the down arrow to the right of the Style option within 

the Line section. Select a line style as required. 
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• When you have made your selections, click on the OK button. 
 
 
 
6.4.3.3 Change arrow start style, arrow finish style. 
 
 
To change the arrow start and end styles 
• Select the arrow. 
• Double click on the arrow to display the Format AutoShape dialog box. 
• If necessary select the Colors and Lines tab within the dialog box. 
• To change the arrow start style, click on the down arrow to the right of the Begin Style 

section of the dialog box, and select the required style. 
 

 
 

• To change the arrow end style, click on the down arrow to the right of the End Style 
section of the dialog box, and select the required style. 
 

 
 

• When you have selected your modifications, click on the OK button to close the dialog 
box and apply the changes. 
 

 
 
6.4.3.4 Apply a shadow to a drawn object. 
 
 
To add a shadow effect to an AutoShape 
• Select the AutoShape to which you wish to apply a shadow effect. 
• Click on the Shadow icon (displayed within the Drawing toolbar). 
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A popup menu will be displayed, from which you can select the required type of shadow 
effect. 
 

 
 
• Click on the required shadow effect and the shadow will be applied, as illustrated. 

 

 
 
 
 
6.4.3.5 Rotate or flip a drawn object. 
 
 
To rotate an object 
• Select the shape which you wish to rotate. You will see a small line with a green spot at 

the end of it, as illustrated. 
 

 
 

• Drag the green spot to rotate the drawing object, as illustrated. 
 

 
 
 
To flip an object 
• Select the shape which you wish to flip. 
• Click on the Draw button (on the Drawing toolbar) and from the popup menu displayed 

select the Rotate or Flip command, which will display a popup submenu, from which 
you can select the desired command, such as Flip Horizontal or Flip Vertical. 
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6.4.3.6 Align a drawn object: left, centre, right, top, bottom of a slide. 
 
 
To align objects using the Draw menu 
• Select the objects you wish to align. Depress the Shift key to select more than one 

object by clicking on the objects. (The other way to select multiple object is to depress 
the left mouse button and draw a rectangular shape over the objects which you wish to 
select). 

• Click the Draw icon on the Drawing toolbar to display the Draw menu. 
 

 
 

• Select Align or Distribute to display the alignment submenu. 
• Choose the type of alignment you want. The selected objects align according to your 

selection. 
 
NOTE: Objects are aligned according to their selection rectangles, rather than the 
shapes themselves. 

 
 
 
6.4.3.7 Resize drawn object, chart within a presentation 
 
 
To resize a drawn object or chart 
• Select the drawn object or chart by clicking on it once. 
• Move the mouse pointer to one corner of the selected item, until the mouse pointer 

changes to a line at 45 degrees with an arrowhead at each end. 
• Depress the mouse button and drag to resize the image within the slide. 
• Release the mouse button. 
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6.4.3.8 Bring an object to the front or back. 
 
 
What is object ordering? 
• When you draw objects on a slide, the first object you draw is on the bottom, and the last 

object you draw is on the top. The placement of objects can be changed using the Bring 
to Front, Send to Back, Bring Forward and Send Backward commands. 
 
NOTE: This is only relevant where two objects overlap on the slide. 

 
 
To bring objects forwards or send them backwards 
• Select the object you wish to move forward or backwards. 
• Right click to display a popup menu, as illustrated. 

 

 
 
• Select Order to display the Order submenu. 
• Select Bring To Front or Send To Back. 
• The selected object is moved to the top or bottom of the stack. 
 
 
 

6.4.4 Duplicate, Move, Delete 
 
 
6.4.4.1 Duplicate a chart/graph, drawn object within the presentation or 
between open presentations. 
 
 
To copy a chart (or drawn object) within a presentation 
• Click once on the chart (or drawn object), to select it. 
• Click on the Edit drop down menu and select the Copy command. 
• Display the slide within the presentation to which you wish to copy the chart (or drawn 

object). 
• Click on the Edit drop down menu and select the Paste command. 
 
 
To copy a chart (or drawn object) from a slide in one presentation to a slide 
within a second presentation 
• Click once on the chart (or drawn object), to select it. 
• Click on the Edit drop down menu and select the Copy command. 
• Switch to, or open the second PowerPoint presentation to which you wish to copy the 

selected chart (or drawn object). 
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• Display the slide within the second presentation to which you wish to copy the chart (or 
drawn object). 

• Click on the Edit drop down menu and select the Paste command. 
 
 
6.4.4.2 Move a chart/graph, drawn object within the presentation or 
between open presentations. 
 
 
To move a chart (or drawn object) within a presentation 
• Click once on the chart (or drawn object), to select it. 
• Click on the Edit drop down menu and select the Cut command. 
• Display the slide within the presentation to which you wish to move the chart (or drawn 

object). 
• Click on the Edit drop down menu and select the Paste command. 
 
 
To move a chart (or drawn object) from a slide in one presentation to a slide 
within a second presentation 
• Click once on the chart (or drawn object), to select it. 
• Click on the Edit drop down menu and select the Cut command. 
• Switch to, or open the second PowerPoint presentation to which you wish to move the 

selected chart (or drawn object). 
• Display the slide within the second presentation to which you wish to move the chart (or 

drawn object). 
• Click on the Edit drop down menu and select the Paste command. 
 
 
 
6.4.4.3 Delete a chart/graph, drawn object. 
 
 
To delete a chart (or drawn object) 
• Click once on the chart or drawn object to select it and then press the Del key. 
 
 
 



PAGE 66 - ECDL MODULE 6 (USING POWERPOINT XP) - MANUAL 

FOR USE AT THE LICENSED SITE(S) ONLY  
© Cheltenham Courseware for Trainers 1995-2004 www.cctglobal.com 

6.5 Slide Show Effects 
 
 

6.5.1 Preset Animation 
 
 
6.5.1.1 Add preset text or image animation effects to slides. Change 
preset animation effects on text or images. 
 
 
To add a preset animation effect 
• Animation effects allow you to add a range of special effects to your slide shows. Click 

on the Slide Show drop down menu and select the Animation Schemes command. 
This will display the Slide Design task pane. 
 

 
 

• Click on the required animation type. 
 
 
To change a preset animation effect 
• Open a presentation containing animation effects. 
• If necessary, click on the Slide Show drop down menu and select the Animation 

Schemes command. This will display the Animation Effects task pane. 
• Select the object of which you wish to change the animation effect, and then select a 

different animation effect from the task pane. 
 

 
 

6.5.2 Transitions 
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What are slide show transitions? 
• Slide show transitions are special effects you can add to a slide show to determine how 

one slide moves or blends into the next slide within the presentation. 
 
 
6.5.2.1 Add transition effects between slides. Change transition effects 
between slides. 
 
 
To add transitions to a slide show 
• Click on the Slide Show drop down menu and select the Slide Transition command. 

This will display the Slide Transition task pane to the right of your screen, as illustrated. 
 

 
 

• Select the transition you require from the task pane. You will see a preview displayed 
within the active slide. Select how fast you want the transition to take place by selecting 
Slow, Medium, or Fast. By default the modification you make this way will only apply to 
the active slide displayed in Normal View. 
 

 
 

• To change the transition of all slides within the presentation, click on Apply To All 
Slides. 
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To change a transition effect 
• To modify an existing transition effect on a single slide, display the slide and simply apply 

a new transition using the Slide Transition dialog box. To apply a new transition effect 
to all slides make sure you click the Apply To All Slides button. 
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6.6 Prepare Output 
 
 

6.6.1 Preparation 
 
 
6.6.1.1 Select appropriate output format for slide presentation such as: 
overhead, handout, 35 mm slides, on-screen show. 
 
 
To set the slide format 
• From the File menu, select Page Setup to display the Page Setup dialog box. 

 

 
 

• Click on the down arrow on the Slides sized for box and choose the required option. 
 

 
 
• In the Orientation section, select the orientation for your slides in the Slides box. 

Choose either Portrait or Landscape. 
• In the Notes, handouts & outline section, select the orientation for your notes, 

handouts and outlines. Choose either Portrait or Landscape. 
• Select OK to accept the slide setup. 
 
 
 
6.6.1.2 Spell-check a presentation and make changes such as: 
correcting spelling errors, deleting repeated words. 
 
 
To use the Spelling Checker 
• Click on the Spelling icon on the Standard toolbar. PowerPoint begins checking the 

spelling. If PowerPoint comes across a word it does not recognise, the Spelling dialog 
box appears. 
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• In the example shown, PowerPoint has found the word ‘Details’ incorrectly spelt with two 

upper case letters. The incorrect word is displayed in the Not in dictionary box. In the 
Change to box a replacement word is suggested, and other possible replacements are 
listed in the Suggestions box. Choose from the following options: 
 
Ignore: Ignores the word. 
 
Ignore All: Ignores all future occurrences of the word found in the document. 
 
Change: Changes the word to the suggested word in the Change to box. You can 
select an alternative word from the Suggestions box. 
 
Change All: Changes all future occurrences of the word in the document to the word of 
your choice. 
 
Add: Adds the word to the custom dictionary. 
 
Suggest: Suggests other replacement words. 
 
When you have finished checking the presentation, PowerPoint displays a message 
telling you it has finished. To exit the spelling checker, select Close. 

 
 
 
6.6.1.3 Add notes (for the presenter) to slides 
 
 
To add notes to a slide presentation 
• Make sure that you are viewing your presentation in Normal View. If necessary, click on 

the Normal View icon at the bottom left of your screen. You will see a section, illustrated 
below, which allows you to “Click to add notes”. Simply click here and start typing! 
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6.6.1.4 Change slide setup, slide orientation to portrait, landscape. 
Change paper size. 
 
 
To set slide orientation and page size 
• Click on the File drop down menu and select the Page Setup command to display the 

Page Setup dialog box. 
 

 
 
• In the Slides sized for section, select the required paper size. 

 

 
 
• In the Orientation section, select the orientation for your slides in the Slides box. 

Choose either Portrait or Landscape. 
 

 
 
• Click on the OK button to confirm your choices. 
 
 
 
6.6.1.5 Duplicate, move slides within a presentation, between open 
presentations 
 
 
To move a slide within a presentation 
• Display the presentation in Slide Sorter view. 
• Select the slide which you wish to move. 
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• Depress the mouse button and drag the selected slide to the location (between two 
slides) to which you wish to move the selected slide. When you release the mouse 
button the slide will moved. 

 
 
To copy a slide within a presentation 
• Display the presentation in Slide Sorter view. 
• Select the slide which you wish to copy. 
• Depress the Ctrl key (and keep it depressed). 
• Depress the mouse button and drag the selected slide to the location (between two 

slides) to which you wish to copy the selected slide. 
• When you release the mouse button the slide will be copied to the required location. 
 
 
To move a slide from one presentation to another presentation 
• Display the presentation in Slide Sorter view. 
• Select the slide which you wish to move. 
• Click on the Edit drop down menu and select the Cut command. 
• Switch to, or open the second PowerPoint presentation to which you wish to move the 

slide. 
• Display the second presentation in Slide Sorter view. 
• Click between the two slides to which you wish to move the original slide. 
• Click on the Edit drop down menu and select the Paste command. The slide will be 

displayed within the second presentation. 
 
 
To copy a slide from one presentation to another presentation 
• Display the presentation in Slide Sorter view. 
• Select the slide which you wish to copy. 
• Click on the Edit drop down menu and select the Copy command. 
• Switch to, or open the second PowerPoint presentation which you wish to copy the slide 

to. 
• Display the second presentation in Slide Sorter view. 
• Click between the two slides to which you wish to copy the original slide. 
• Click on the Edit drop down menu and select the Paste command. The slide will be 

displayed within the second presentation. 
 
 
 
6.6.1.6 Delete a slide, slides. 
 
 
To delete a slide using the drop down menus 
• Display the slide which you wish to delete. 
• Click on the Edit drop down menu and select the Delete Slide command. 
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To delete a slide using the Del key 
• Display the presentation in Slide Sorter view. 
• Select the slide which you wish to delete. 
• Press the Delete key on your keyboard. 
 
 
To delete multiple slides (in one action) 
• Display your presentation within Slide Sorter view. 
• Click on the first slide which you wish to select. 
• Depress the Ctrl key (and keep it depressed). 
• Click on the other slides which you wish to select for deletion. 
• Release the Ctrl key and press the Del key. 
 
 
 

6.6.2 Printing 
 
 
6.6.2.1 Print entire presentation, specific slides, handouts, notes pages, 
outline view of slides, number of copies of presentation, print 
presentation to file. 
 
 
To print your entire presentation 
• Click on the Print icon, displayed within the Standard Toolbar. 

 

 
 
 
To print just the current slide 
• Display the slide which you wish to print. 
• Click on the File drop down menu and select the Print command. 
• In the Print range section of the dialog box, select the Current slide button. 

 

 
 

• Make other selections as required and then click on the OK button. 
 
 
To print particular slides 
• Click on the File drop down menu and select the Print command. In the Print range 

section of the dialog box, select the Slide button. In the example shown we have 
decided to print slide 1, slide 2 and slides 5-8 inclusive. 
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• Make other selections as required and then click on the OK button. 
 
 
To print multiple copies 
• Click on the File drop down menu, displayed within the Standard Toolbar, and select the 

Print command. In the Copies section of the dialog box, use the up and down arrows to 
set the required number of copies. In the example shown, we have set 5 copies to be 
printed. 
 

 
 
• Make other print choices as required and click on the OK button. 

 
 
To print a presentation to a file 
• Click on the File drop down menu, displayed within the Standard Toolbar, and select the 

Print command. In the Printer section of the dialog box, click on the Print to file check 
box. 
 

 
 

• Make other print choices as required and click on the OK button. 
 

 
To print Handouts 
• Click on the File drop down menu and select the Print command. A dialog box is 

displayed. 
• Click on the down arrow to the right of the Print What section of the dialog box. 
• Select Handouts from the drop down menu displayed. 

 

 
 

• Select the number of Slides per page, and whether you wish them displayed 
horizontally or vertically. 

• You can also, optionally, select the Scale to fit paper box. 
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• You may wish to enter a number in the Number of copies section of the dialog box, so 
that you can print multiple copies. Click on the OK button to start printing. 

 
 
To print Notes or a Presentation Outline 
• Click on the File drop down menu and select the Print command. A dialog box is 

displayed. 
• Click on the down arrow to the right of the Print What section of the dialog box. 
• Select Notes Pages or Outline View from the drop down menu displayed. 

 

 
 

• You can also, optionally, select the Scale to fit paper box. 
• You may wish to enter a number in the Number of copies section of the dialog box, so 

that you can print multiple copies. Click on the OK button to start printing. 
 
 
 

6.6.3 Deliver a Presentation 
 
 
What is a Slide Show? 
• Rather than printing out your presentation, you may want to run it as an electronic slide 

show from your computer. This means that each slide in your presentation, along with its 
text, art, and graphics, takes up the whole screen. All other screen elements are hidden. 

 
 
 
6.6.3.1 Hide or show slides. 
 
 
To hide slides in a slide show 
• Select the slide(s) you wish to hide. 
• Select Hide Slide from the Slide Show menu, or click on the Hide Slide icon on the 

Slide Sorter toolbar if you are working in Slide Sorter view. 
• The slide will be hidden during a slide show. 
• In Slide Sorter view an icon appears below the slide, which contains the slide number 

with a line through it, to indicate that it is hidden. 
 

 
 

• During a slide show if you wish to display a hidden slide simply press the H key on the 
preceding slide.  
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To see which slides are formatted as hidden 
• Switch to Slide Sorter view and the hidden slide(s) will be indicated as illustrated below. 

 

 
 
 
To display a hidden slide during a slide show 
• During a slide show if you wish to display a hidden slide simply press the H key whilst 

the preceding slide is being displayed.  
 
 
 
6.6.3.2 Start a slide show, start a slide show on any slide. 
 
 
To start a slide show (from the beginning) 
• Click on the Slide Show drop down menu and select the View Show command. 

OR press the F5 key. 
 
 
To start a slide show on a specific slide 
• Display the slide on screen with which you wish to start the presentation (i.e. in Normal 

Mode or Slide View Mode). 
• Click the Slide Show icon to start the presentation. 
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To display the slide show shortcuts 
• When the slide show is running press the F1 key to display a list of shortcuts. 

 

 
 
 
To move to the next slide 
• Use any of the following options: 

Left Mouse Click 
N 
Space Bar 
Right Arrow 
Down Arrow 
Enter  
Page Down 
Right Click - Select from Popup Menu 

 
 
To move to a previous slide 
• Use any of the following options: 

Backspace 
P 
Left Arrow 
Up Arrow 
Page Up 
Right Click - Select from Popup Menu 

 
 
To return to the first slide 
• Press both mouse buttons for 2 Seconds. 
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To blank the screen to black 
• Press B once to apply. 
• Press B once more to remove. 
 
 
To blank a screen to white 
• Press W once to apply. 
• Press W once more to remove. 
 
 
To exit a screen show 
• Use any of the following options: 

Esc 
Ctrl+Break 
“-“ 

 
 
The slide show "right click menu" 
• Right clicking within the slide show will display the following popup menu, allowing you to 

navigate through the presentation. 
 

 
 


